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1 Introduction
1 Introduction

The PC software, WINplus, serves as a communication platform to link any of the ARGUS 
handheld testers with your PC. With it, you can view a clear tabular and graphic 
presentation of all of the test results on the screen and easily generate a printout of an 
access acceptance report – for example for xDSL, ISDN, VoIP, IPTV, copper tests and 
so on.

All of the ARGUS testers can be conveniently configured using a PC. WINplus also 
enables you to store ARGUS test configurations on the PC, to edit them there, or compare 
or archive them and then, if needed, to transfer them back to the tester.

The analysis software, WINanalyse, is an extension of the WINplus software. In addition to 
the functions mentioned above, however, WINanalyse can also capture errors that occur 
while setting up an xDSL connection or during an xDSL connection and then display them 
in their proper order in time and compare them to other various xDSL parameteres. 

Furthermore, it is possible to perform long-term analyses using an xDSL or IPTV online 
trace. In this case, depending on the previously selected settings, the results will be either 
displayed in the form of statistics or presented graphically in their proper order in time on an 
axis. In this manner, you can analyse the bit rate, the signal to noise ratio or the error 
counter totals in connection with the loss of synchronization on the xDSL connection.

WINanalyse also supports an extensive set of ISDN functions: Using an ARGUS as a 
D-channel monitor, you can record data, pass it directly to WINanalyse and decode it in 
real-time. In addition, the software offers the option of displaying the D-channel data in a 
table and presenting the interpreted results in the form of clear text in a separate window. 
As an option, WINanalyse adds the feature of comprehensive D-channel protocol analysis 
to any of the supported ARGUS handheld testers. The software decodes DSS1, X.25 in the 
D-channel, V5.2 and other protocols and can simultaneously record the data from several 
D-channels.
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2 Software at a Glance
2 Software at a Glance

WINplus

The PC software, WINplus, is a communication interface to link the ARGUS handheld 
testers with a PC. The software can be used to view both a clear tabular and a graphic 
presentation of all of the test results on the screen and to easily generate a printout of an 
access acceptance report – for example for xDSL, ISDN, VoIP, copper tests or IPTV.

Furthermore, WINplus can be used to configure ARGUS testers using a PC: A tester's 
existing configuration can be downloaded to a PC, where it can be edited or compared with 
other configurations and then archived on the PC or immediately saved back to the tester.

WINanalyse

WINanalyse supports not only all those WINplus features for presenting results from an 
ARGUS tester on a PC but also additional analysis functions for evaluating the results of 
tests. Using this software, it is possible to capture errors that occur while setting up an 
xDSL connection or during an xDSL connection. The captured errors will be displayed 
together with the various xDSL parameters in their proper order in time. The long-term 
results of these xDSL or IPTV online traces will be presented in the form of clear graphics. 
These graphics make it much easier to evaluate bit rates, signal-to-noise ratios or the error 
counters related to the loss of synchronization.


Furthermore, WINanalyse can be used to add an optional feature to the ARGUS®145PLUS, 

ARGUS®125 or ARGUS®126 testers that enables them to perform comprehensive 
D-channel protocol analysis on ISDN networks. The software decodes the D-channel data 
recorded by one of these ARGUS testers - acting as a D-channel monitor - in real-time. 
WINanalyse can then present this data as a table or in the form of interpreted clear text in a 
separate window. The software decodes DSS1, X.25 in the D-channel as well as other 
protocols and can simultaneously record the data from several D-channels.

When tests are run on PRI accesses, WINanalyse offers a graphic display of the results of 
a MegaBERT with analysis functions.

Update Tool

A free update tool is available to update ARGUS testers. This tool is also included on the 
CD-ROM with WINplus and WINanalyse. Using this tool, the tester's firmware can be kept 
up-to-date by downloading the latest version for the device from www.argus.info. 

For the sake of clarity, the remaining description will only refer to WINanalyse. 
The features of WINplus simply constitute a subset of those of WINanalyse. The 
serial key entered during the installation determines whether the WINplus or 
WINanalyse software will be installed.
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3 The WINanalyse Software
3 The WINanalyse Software 

Both WINplus and WINanalyse are compatible with Windows XP, Windows Vista and 
Windows 7 (including 64 bit). To ensure proper operation and the best usability of either 
program, the PC should satisfy the following minimum requirements:
 
- CPU - 1 GHz clock

- At least 50 MB of space free on the hard disk

- RAM 256 MB

- One USB port free

- A COM port free (only required for older equipment)

3.1 Installing the WINanalyse software

The software can be installed in two different ways.
1. Installation from the included CD:

The installation will begin automatically after the CD is placed in the drive (if the 
"Autostart" function is enabled on the PC). 

2. Installation from the download area of the www.argus.info web page.

Download the WINanalyse software

Besides the installing the 
software from the included CD, 
it is also possible to download 
the most recent version of the 
software from the 
www.argus.info web page. 
1. Click on "Service" in the 
navigation bar.
2. Then click on "Downloads".
3. In the now open window click 
on "WINplus/WINanalyse".

3.

1.







2.
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3 The WINanalyse Software

Select the variant appropriate for 
your equipment.
Start the download by clicking on  
"0x_WINanalyse-
WINplus_Software_x_V_x_xx.
zip". 








Confirm your choice by clicking 
on "OK".













The download will begin.
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3 The WINanalyse Software

Open the downloaded file and 
unpack it with a suitable 
program.











Open the unpacked directory 
"Disk1" and click on 
"setup.exe" to start the 
installation.











The start window for the 
installation will open.










Click on "Next" to continue.
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3 The WINanalyse Software

After entering a user name, a 
company name and a valid CD 
key (activation key) you can 
continue the installation by 
clicking on "Next". 

You will receive a valid activation 
key (serial key on the silver label 
on the sleeve) with your 
CD-ROM or can request one 
from our Support 
(support@argus.info). 



After selecting the components 
to be installed, you can continue 
the installation by clicking on 
"Next" or you can first click on 
the "Browse" button and select 
where the files should be saved 
(the recommended components 
are already marked).

The procedure also includes 
installation of the USB driver 
required when connecting an 
ARGUS tester.



The software will be installed 
after you confirm your choices 
by clicking on "Finish".








The installation is now finished.
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3 The WINanalyse Software
3.2 Uninstalling the WINanalyse software


Select "Control Panel" in the 

Windows Start menu.













Click on “Programs”.










Select the program to be 

uninstalled (in the example 

"ARGUS Software 2.55.0").
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3 The WINanalyse Software

The software will be uninstalled.








 





The uninstallation is completed 

after you click on "Finish".











The trace data and test logs saved before uninstallation of the software remain 

untouched. 
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3 The WINanalyse Software
3.3 Getting Started

3.3.1 Connecting a hand-held tester

Use the USB cable included with WINanalyse or the USB serial adapter to connect your 
ARGUS tester to a free USB port on your PC. 

Depending on the type of tester, the connection will be made using one of the following 
cables:

Connections

USB cable or Mini-USB cable

Serial USB cable (RJ-11 to USB)
USB serial adapter




On older devices, other cables are normally used. For more information, please contact our 
Support. 

Once the ARGUS is connected, the installation of the necessary driver will begin 
automatically.

3.3.2 Installation of Hardware under Windows XP

Hardware installation under Windows Vista is performed in the same manner as under 
Windows XP. Under Windows 7, the installation is performed automatically. Nonetheless, it 
is advisable to install WINanalyse and the associated USB driver before beginning the 
hardware installation.


In the current window select 

"Install the software 

automatically 

(Recommended)" and click 

"Next" to continue.
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3 The WINanalyse Software

The system will automatically 

begin to search for the "ARGUS 

over USB" driver software.












Click on the "Continue 

Anyway" button to proceed with 

the installation.










To quit the installation, click on 

"Finish".
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3 The WINanalyse Software
3.4 Starting WINanalyse

On your Desktop, double-click on the  icon to start WINanalyse. If you did not have the 

icon on your Desktop, start the program via the Windows Taskbar. To do so click on  and 

select "Programs". Afterwards, an overview of all installed programs will open in which the 
"ARGUS Software" directory can be found. In this directory, you can start WINanalyse by 
clicking on its icon or name. 

Setting the installer (company) address


When WINanalyse is first started, a window will open 
automatically in which you can enter your company’s 
address. This information will later be used in the 
measurement or test reports. 



Setting the standard directories

To change the location where 
your files will be saved, open the 
"File" menu and select 
"Standard Directories".
A dialog box will open in which 
you can set the directories to be 
used for your 

– Tracefiles,
– Measurement protocol,
– Configuration files and 
– Filter 
on your PC.

Configuration of the Auto-Save

To configure the auto-save, click 
on "Auto Save" in the "File" 
menu. 
A dialog box will open in which 
you can specify when your data 
should be automatically saved. 
When data is auto-saved, a new 
time-stamped file (with the date 
and time that the file was saved) 
will be created in the previously 
configured directory.
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4 Workspace
4 Workspace 

The WINanalyse workspace is arranged to provide easy access to the functions needed to 
analyse and process test logs and also those for configuring the ARGUS. It includes menus 
and a multitude of functions which may change depending on the type of test log.

4.1 Basic Layout of the Workspace

A large number of functions are available to make the analysis or viewing of test logs or 
editing configurations more convenient. These functions are directly accessible in the 
workspace and can be configured to suit you individual needs.
The standard layout of the workspace, which is displayed when WINanalyse first starts, is 
as follows:

A

B
C
D

E

G

WINanalyse - Standard Workspace
A. Menu bar B. Standard toolbar C. Window toolbar D. Protocol selection E. ARGUS configuration 
F. Status line G. Work window

F



The standard workspace can be customized to suit your specific needs. To customize the 
workspace, go to the menu and select "View/Toolbar" where you can enable both a 
graphics window and a decoder toolbar. The decoder toolbar will be displayed 
automatically when a test log is opened.

All of the toolbars may be moved within the workspace. Any changes made to the layout of 
the workspace will be automatically saved when the trace data is closed. The changed and 
saved layout becomes the new "standard" layout.  
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4 Workspace
4.2 A - Menu bar 

File

Connect to the ARGUS + Select the data source.

ARGUS Configuration + Open the configuration management.

Open... Open compatible files and the associated window 
settings.

Close Close the currently open test log.

Save + Save the test log currently used under its current 
(same) name.

Save as... Save the test log currently used under a different 
name.

Close and new... Close the current trace and begin recording a new 
trace from the same source. 

Open trace file Open a trace file and the associated window 
settings.

Open test log file... Open a previously saved test log.

Export trace data... Export an entire trace file or any portion of a trace 
as text.

Export Graphic... Export the data of a selected graphic as a .csv file 
(e.g. bits/tone).

Export MP in csv... Export the test log as a .csv file.

Print + Print selected trace tables, decoded data or 
graphics.

Print Setup... Configuration of the selected printer (e.g. print 
quality, format etc.).

Recent Files 
Test logs

Display the last four test logs opened. 

Exit Close WINanalyse.

If all files are closed:

Standard Directories Set the standard directories used when opening 
or saving files.

Installer Address Save the address of the installing company for 
use in test logs.

Auto save Automatically saves a trace recording after a 
previously set period of time or a specific number 
of trace entries. 
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4 Workspace
Edit

Copy + Copy the marked content.

Find + Search for any specified term in the decode and/
or trace windows (see page 21).

Filter Both general and ISDN-specific filters can be 
configured in the Filter dialog.

View

Toolbar Display/Hide the selected windows and toolbars.

Status bar Display/Hide the status bar.

ARGUS Terminal Log Display ARGUS-specific content regarding a 
trace file.

Save Window Settings Saves the custom window settings.

Load Window Settings Loads window settings that were previously 
saved.

Export Window Settings Exports window settings that were previously 
saved.

Import Window Settings Imports window settings that were previously 
saved.

Change Active View
+

Switches the view between various menu bars.

Maximize Trace Window Maximizes the trace window while minimizing the 
decode window.

Maximize Decode Maximizes the decode window while minimizing 
the trace window.

Trace and Decode Set the trace and decode windows to the same 
size display.

Split Window Display a second identical trace window. 

New View Restores the previously adjusted display of the 
trace and decode windows to the default settings.
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4 Workspace
Test Result

Next page Switches to the next page (tab) in a test log. 

Previous page Switches to the previous page (tab) in a test log.

Export in csv... Export the test log as a .csv file.

Trace

Connection Connect to / Disconnect from the ARGUS.

Auto-scroll Enable / Disable auto-scroll in a window.

Change Trace Direction Change decode direction.

Decode

Headline Displays an extended header with additional 
information.

Hex. View The signal will be presented in hexadecimal 
coding in the decode window under the heading 
Hex data.

Layer 2 Select the degree of analysis of Layer 2.

Layer 3 Select the degree of analysis of Layer 3. 

Line Feed Adjusts the text to fit the size of the decode 
window.

Protocol Select the protocol.

Manual Data Input... Analysis of a selected signal.

Segmented Messages The ARGUS will automatically join segmented 
Layer 3 messages together and display them in 
the decode window.
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4 Workspace
Window

New Window Opens a copy of the active window.

Cascade Displays all of the open windows overlapped at 
the same size.

Tile Horizontally Displays all of the open windows at the same size 
tiled one above the other.

Tile Vertically Displays all of the open windows at the same size 
tiled horizontally next to each other.

Arrange Minimize the windows sorted at the lower edge of 
the display.

"Recent Files"  The selected file will be brought to the foreground.

Help

Info... Displays the information window.

Contents Displays the help function.
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4 Workspace
4.3 B - Standard Toolbar

Connect to ARGUS A window of the available sources will open. 
To connect the ARGUS to the PC, select the 
PC port to which your tester is connected and 
then click on "OK".

ARGUS Configuration The ARGUS Configuration window will open in 
which you can manage the configurations.

Open file A dialog box will open displaying the saved 
test log files and trace recordings 
(e.g., Example ADSL.amp). 
Mark the desired file and then click on 
"Open". Afterwards, the selected file will open 
in the WINanalyse workspace.
Multiple test logs can be opened and analysed 
at the same time.

Save to file Using the "Save" (and "Save As...") 
function(s), you can save your test logs / trace 
recordings (under any name).  
If the system crashes, WINanalyse will 
reconstruct your data.

Close and New... Click on "Close and New..."  to close the 
current recording and save the results under 
any name desired. Afterwards, more data will 
be recorded from the trace source previously 
selected.

Copy Copies the marked data and places it on the 
clipboard.

Find A dialog box will open to allow you to search 
the decode or trace window for any term. The 
search process can be refined by selecting 
one or more of the available options.
To display the various options, click on the 

  button.

Print A dialog box will open in which you can 
choose between printing a whole test log or 
just a specific portion of one.
When printing a recording you can specify 
whether to print the entire trace table, the 
content of the decode window or a displayed 
graphic. 
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4 Workspace
Info Information about WINanalyse and intec 
Gesellschaft für Informationstechnik mbH will 
be displayed if you click on this button. If you 
click on "www.argus.info" or "Internet", 
a connection to our home page will be 
established directly.

Help Depending on the version of WINanalyse that 
you have, if you click on this help tool and then 
a button, page (tab), or a test log you can read 
related information about it. 
In such cases, a window will open in which 
information about the object will be displayed 
(if it was automatically recognized) or in which 
you can search for the desired information.  
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4 Workspace
4.4 C - Window Toolbar

Save Window Settings Click on this button to save the individual 
settings (e.g. column width) for a screen 
layout.

Load Window Settings A dialog box will open in which you can select 
and load window settings that were previously 
saved. 

Table Click on the "Table" button to display just the 
trace window. All other windows will be 
minimized.

Trace + Decode Click on the "Table + Decode" button to 
display both the trace and the decode 
windows. All other windows will be minimized.

Decode Click on the "Decode" button to display just 
the decode window. All other windows will be 
minimized.

Filter configuration You can filter various signals in the trace 
window. To do so, click on the "Filter 
configuration" button. A window will open in 
which you can select the desired filter 
configuration. The configuration can then be 
saved for reuse at any time.  

Filter on/off The filter configuration set up before can be 
activated or deactivated by clicking on this 
button.

ARGUS Terminal Log Click on "ARGUS Terminal Log" to open a 
window in which the ARGUS Info text for the 
currently open file or connection will be 
displayed. Later, the corresponding log file 
can be saved.

4.5 Decoder Toolbar

Next page Click on this button to open the first page (to 
the right).

Previous page Click on this button to open the first page (to 
the left).
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4 Workspace
Scroll automatic The recorded signals will be presented online 
on the screen of the PC. To analyse the 
signals at your leisure, you can “freeze” the 
screen. 
To do so, click on the "Scroll automatic" 
button. Click on the button a second time to 
deactivate the “Freeze screen” function.
Signals received while the screen is "frozen" 
will be recorded in the background and can be 
viewed at a later point in time.

Data Record on/off The recording of data can be interrupted at 
any time. To do so, click on the "Data Record 
on/off" button. Click on the button again to 
resume recording the signals.

Adjust Cell Height Click on this button to adjust the height of the 
trace table cells so that all of the information in 
the cells will be displayed.

Normal Cell Height This button restores the cells to their normal 
height.

Display Headline General information will be displayed about 
the signal under the heading ISDN D-channel 
in the decode window.

Hex. View The signal will be presented in hexadecimal 
code in the decode window under the heading 
HEX data.

Layer 2, 
depth of analysis = 1

General Layer 2 information will be displayed 
under the heading Layer 2 (L2).

Layer 2, 
depth of analysis = 2

Additionally, the L2 frame’s bits will be 
decoded and displayed.

Layer 3, 
depth of analysis = 1

The name of the Layer 3 message will be 
displayed under the heading Layer 3 (L3).

Layer 3, 
depth of analysis = 2

The content of the most important Layer 3 
information elements will be displayed under 
the heading Layer 3 information elements.

Layer 3, 
depth of analysis = 3

All of the Layer 3 information elements will be 
displayed in clear text.

Layer 3, 
depth of analysis = 4

The bits of the signal frame will be decoded in 
addition.
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4 Workspace
4.6 D - Protocol Selection

Segmented Messages Related segmented messages will be 
decoded together.

Protocol Selection If other protocols are enabled, the protocol 
that should be used for decoding can be 
selected from the pull-down menu here.
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4 Workspace
4.7 Window Settings

Save Window Setting


To save the current window settings, click on "Save 
Window Setting" in the View menu. Alternatively, you can 
also simply click on . 

A dialog box will open displaying the ten window setting 
records. Select the record (memory location) to be used for 
saving the window settings.  
You can enter a name for the window settings in the 
"Name:" field. Afterwards, click on "OK" to finish the 
procedure.






Load Window Setting


To load previously saved window settings or to restore the 
default (standard) settings, click on "Load Window 
Setting" in the View menu. Alternatively, you can also 

simply click on . 

A dialog box will open from which you can open one of the 
ten possible window settings. Select the desired setting 
and click on "OK".





Export Window Setting

To use one of the saved settings on a different PC so that 
you can avoid having to define the same settings there, 
click on "Export Window Setting" in the View menu.
Afterwards, a dialog box will open displaying the previously 
defined window settings. Select the window setting to be 
exported and then click on "OK".

You can also click on the  button to specify where the 

file should be saved. 
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4 Workspace
Import Window Settings


The export function is complemented by a corresponding 
import function. To import window settings which have 
previously been exported, click on "Import Window 

Setting" in the File menu. Afterwards, use the  button 

to select the file to be imported.
In the list of settings, select the one to be overwritten. If you 
want to rename the window setting, enter the new name in 
the "import as" field. Afterwards, click on "OK" to finish 
the procedure. 
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5 Configurations
5 Configurations

The ARGUS Configurations program can be started in the following manner: 
Start the configuration from the Windows 

Start menu . Begin by selecting the 

program group "ARGUS Software" and 

then click on the  "ARGUS 

Configurations" icon.

The "ARGUS Software" program group 

 
If WINanalyse has already been started, 
configurations can be started by clicking on 

the  icon in the standard toolbar or by 

selecting "ARGUS Configuration" in the 
"File" menu.


Selecting the port

Once you have started "ARGUS 
Configurations", the following window will 
open:
In this window, you can select - from the list 
of available sources - the data source that 
you want to edit or manage and then 
confirm your selection by clicking on "OK". 




An Alternative for Starting ARGUS Configurations

If you have already connected your ARGUS 

to WINanalyse by clicking on the  icon, 

you can open configurations by clicking on 
"ARGUS Config". 
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5 Configurations
5.1 Configuration management

Once you have started the configuration management, you can use your PC to manage 
and edit various configurations for your ARGUS. These configurations include all of the 
parameters that you find under the "Settings" on your ARGUS.

Configuration management 

On the left side of the "Configuration management", you will find a list of all of the 
configurations that have been saved in the "Standard directories" directory on the PC.  
Whatever operation is selected by clicking on one of the buttons will be performed on the 
configuration selected in this list.

Functions

The directory used to store configurations on the PC can be changed 
temporarily by clicking on this button.

Opens a new window into which the current configuration of the ARGUS 
can be loaded on the PC.

Opens a new window into which the default configuration of the ARGUS 
can be loaded on the PC.

Sends the currently selected configuration from the PC to the ARGUS.

Opens a new window in which the selected configuration can be edited.



Click this button to rename an existing configuration.

Deletes the selected configuration. This will also delete the configuration 
file from the PC's hard disk.

Click on this button to close the configuration management window.
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5 Configurations
5.2 Saving a Configuration 


Click on the "Directory" button to 
temporarily change the directory in which 
configuration files will be saved on the PC. 
After clicking on this button, a dialog box will 
open in which you can select the directory in 
which you wish to save configuration files. 
The desired directory can be either entered 
using the keyboard or you can select it with 
the mouse. Afterwards, confirm your entry 
with "OK".












5.3 Uploading a Configuration from the ARGUS

The configuration management offers two options for copying configurations from the 
ARGUS to the PC. For one, if you click on "Current", the currently used configuration will 
be copied from the ARGUS to the PC. For another, if you click on "Default", the default 
configuration or the factory settings will be copied from the ARGUS to the PC. In both 
cases, the following window will open:


First, specify where the configuration file 
should be saved. Then click on "Upload" to 
copy the current or default configuration 
from the ARGUS to the PC. Afterwards, the 
newly created file will appear in the list on 
the left of the configuration management 
window.
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5.4 Sending a Configuration to the ARGUS

Once you have started the configuration 
management program, select the directory 
in which the configuration file may be found. 
Afterwards, select the desired configuration 
file from the configurations table and then 
click on the "to ARGUS" button. 


To begin the transfer, you must click on 
"OK" to confirm that you want to send the 
configuration to the ARGUS and thus 
overwrite the current configuration of the 
ARGUS. 



ARGUS has to be in idle mode, when transferring configurations. The idle mode 
means that no test interfaces are in use or even tests are running. In this case, 
WINanalyse will show an error message. To continue, please terminate all 
running tests and disconnect ARGUS from the test interface(s).
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5.5 Editing an Existing Configuration

The configuration management makes it easy for you to edit your configurations. The 
configuration settings supported are the same as those on the ARGUS itself.

To edit a configuration, select the desired configuration file in the configuration table and 
then confirm your selection by clicking on "Edit" or by double-clicking on the file name. The 
following window will then open: 

ARGUS Configuration:
A. Administration toolbar B. Configuration overview C. Configuration window

A

B

C

The configuration overview provides a summary of all the configuration points available. 
These points can be edited and managed in the configuration window. If you have made 

changes, the branch altered will be marked in the configuration overview with an "x" at the 
end. Afterwards, the administration toolbar can be used save or discard these changes.  
Functions such as e.g. "Collapse branch" or "Discard changes" can be found in the 
context menu. 

Administration toolbar

Save the changes made.

Save the changes made under the specified path and name.

Discard all changes made in this session.

Copy the content of a profile (includes: profile type, source and the 
destination).

Close the window and discard the changes made.
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6 Test Logs

6.1 General Structure of a Test Log

6.1.1 An Example of the Layout of a Test Log

The layout of a test log may differ depending on the access and configuration. The 
following examples illustrates the possible layouts.

Starts screen of an WINanalyse Test log
A. executed test  B. type of Service C. Virtual Line  D. Access

A

B

C

D

In the overview it is possible to fade in or remove tabs when clicking an executed test 

(element A), a service (B), a virtual line (C) or the Layer 1 (D).
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WINanalyse - Test Log
A. Customer information B. Tab Set 1 C. Tab Set 2  D. Test summary  E. ARGUS information 
F. Date/Time G. Own company name  H. Customer data selection

A

H G F

E

C

B

D
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6.1.2 The tabs

The following three tables show all of the possible tabs. These differ depending on the type 
of access. They show all of the access and test parameters as well as all recorded test 
results, sorted alphabetically in three hierarchical levels.
For more information on the various signals, test and connection parameters, please see 
the ARGUS manual.

Tab Set 1  
(Section B of the test log, see page 34)

Tab Category Explanation

Access all Displays selected access and access mode.

ATM OAM ping ADSL/SHDSL Displays the availability of individual network nodes.

B-channels ISDN Displays the B-channels.

BERT ISDN Displays the results of a bit error rate test.

Call Forwarding ISDN Displays the type, service and destination of a call diversion set up.

Config. DSL/ETH Displays the configuration previously set.

Data DSL/ETH Displays all information about the Service Data.

Download DSL/ETH Displays the results of a download test and the configuration.

Features ISDN Displays the availability of supplementary services on the access under 
test.

IPTV DSL/ETH Displays the results of an IPTV test and the configuration.

L1 Alarm ISDN Displays Layer 1 alarms/messages and the status of the PRI access.

Line results DSL/ETH Displays detailed test results in the subordinate tabs 
(see Table: Tab Set 2, page 36).

Loading DSL/ETH Displays the results of an upload test and the configuration.

Loop SHDSL/ETH Displays the results of a loop and the configuration.

MDI DSL/ETH Displays the results of an MDI analysis and the configuration.

Notes all Field for entering additional information.

Overview all Gives an overview of the profile and its associated virtual lines and tests.

PESQ all Displays the PESQ value.

Ping DSL/ETH Displays the results of a Ping test and the configuration.

Services ISDN Displays the results of a Service Check.

Traceroute DSL/ETH Displays the results of a Traceroute test and the configuration.

VL x DSL/ETH Displays the used virtual lines.

VoD DSL/ETH Displays the used Video on Demand parameters.

VoIP DSL/ETH Displays the VoIP configuration, the results and the SIP log (for details 
please see Tab Set 2 page 36).

VoIP call DSL/ETH Displays the VoIP call parameters.

Voltage ISDN Displays the signal level and the supply voltage.

VPI/VCI ADSL/SHDSL Displays the VPI/VCI channels available.

X.31 ISDN Displays the availability of the D-channel and any diagnostic codes.
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Tab Set 2  
 (Section C of the test log, see page 34)

Tab Category Explanation

ADSL ADSL Displays the interface information and the evaluation of the results.

Assigned config. DSL/ETH Displays one of the DHCP assigned configurations.

Bits/Tone ADSL/VDSL Tabular or graphic display of the bit distribution (transported bits per tone, 
carrier frequency or channel).

Cap. List SHDSL Displays the SHDSL capability (feature) list.

Config. DSL/ETH Displays the configuration previously set.

DMT analysis Cu test Graphic display of the DMT analysis.

Ethernet DSL Displays the DSL bridge or router configuration on the LAN side.

Graphs ADSL Graphic presentation of the bits and SNR per tone.

HLOG/Tone ADSL/VDSL Graphic presentation of the amplitude component of the transfer function 
(HLOG) for each tone

IPTV test DSL/ETH Displays the results of an IPTV test and the configuration.

Line VoIP Display of the log of the SIP messages and status codes exchanged.

Line 1 - 4 SHDSL Displays the results for each SHDSL wire pair used.

Line scope Cu test Graphic display of the Line scope results.

MOS VoIP Displays the MOS information (speech quality).

Packets IPTV Displays the IPTV packet information.

PPP Trace DSL Chronological presentation of the sequence of PPP messages.

QLN/Tone ADSL/VDSL Displays the quiet line noise (QLN) for each tone.

Result ADSL Tabular display of the ADSL connection parameters.

RTCP VoIP Displays the RTCP Infos sent from the remote end.

RTP VoIP Displays the packet statistics or RTP Infos.

SHDSL config. SHDSL Displays the interface information.

SNR/Tone ADSL/VDSL Tabular or graphic display of the signal-to-noise ratio (SNR) per tone. 

Statistics DSL/ETH Displays WAN, LAN, ATM and PPP parameters.

Stream IPTV Displays the PID (Packet Identifier) information and error counters.

Talk VoIP Displays the call information.

TDR Cu test Graphic display of the TDR results.

Trace DSL/ETH Displays the Modem trace.

VDSL VDSL Displays the VDSL connection information. (for details, see Tab Set 3).

VL result DSL/ETH Displays the virtual line connection parameteres.

VoIP config. DSL/ETH

VoIP
Displays codec, telephone and SIP parameters.

Tab Set 3  

Tab Category Explanation

General VDSL Displays the interface information and the evaluation of the results.

EOC SHDSL Displays the EOC channel information.

Result VDSL Tabular display of the VDSL connection parameters.
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6.2 Managing and Evaluating Test Logs 

6.2.1 Establishing a connection to WINanalyse / WINplus

Activate the PC connection


To connect the ARGUS to WINanalyse / 
WINplus, you must first activate the PC 
connection on the ARGUS (in this example, on 
an ARGUS 145 plus).

In the ARGUS Main menu, select "Settings".






In the Settings menu select "Trace/ remote".











In the Trace/ remote menu, select 
"Auto PC sync".
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Connecting WINanalyse / WINplus to the ARGUS


To connect the PC to the ARGUS, open the 
"File" menu and select "Connect to 
ARGUS".
Alternatively, press the key combination  

+  or click on the  button.












In this window, you can select - from the list of 
available sources - the data source that you 
want to open and then confirm your selection 
by clicking on "OK".
A window will open showing the current 
connection data.





6.2.2 Sending test results to a PC


To send the desired test results from the 
ARGUS to the PC, select "Test results" in the 
Main menu.
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Then select the test result to be sent.











The desired function will be performed once 

you confirm with . If you have selected 

"Send report to PC", the test result will be 
opened in WINanalyse / WINplus.

If instead you selected "All tests to PC", all of 
the test logs stored in the ARGUS will be sent 
to the PC one after the other. This could 
amount to as many as 50 logs.

To send a test log to the PC, it is not necessary that the ARGUS be in the Trace/ 
remote setting"Auto PC sync" or "Manual PC sync". To send a test log, it is 
enough if the corresponding COM port is open in WINanalyse.


6.2.3 Saving a test log


In the "File" menu, select "Save As…". 
A dialog box will open in which you can enter 
the path and file name that should be used 
when saving the test log. Afterwards, click on 
the "Save" button.
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6.2.4 Opening a previously saved test log.

In the "File" menu, select "Open test log". 
A dialog box will open that, on the left side, lists 
all of the previously saved test logs (e.g. 
customer1.amp). Select a log by clicking on its 
file name. Click on "Open" to open the test log 
in WINanalyse. Alternatively, you can also 

simply click on .





6.2.5 Printing a test log

Click on  to print the desired test log. 

Alternatively, you can open the "File" menu 
and click on the same function.
Afterwards, a dialog box will open in which you 
can select whether you want to print an entire 
test log or just a selected section of one. 
If you only want to print part of a test log, the 
"Print range" setting "Selection" must be 
selected. When this is selected, the options list 
below will be then enabled to allow you to 
select which components should be printed. 
If you also check the "Print attachment" box, 
the test log itself (ADSL only) with the entire 
tabular presentation of the counter values per 
tone for Bits, SNR, QLN and HLOG will be 
attached. This can, of course, grow up the print 
out considerably.
Additionally, you can set the print range, the 
printer and the number of copies as desired.
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6.2.6 Test log functions

The following shows an example of the user interface of a test log. Various functions that 

can be performed within a test log are indicated in sections A to D.

A

D

C

An overview of the functions illustrated in the example of a VDSL test log
A. Customer selection B. Quick selection of the analysis area 
C. Zoom box buttons D. Detailed measurement point information

B




























A. Customer selection

Up to 15 customer addresses, 
which can be selected using the 
arrow keys on the right edge, 
can be stored here.
The customer data from the 
currently open test log can be 
entered into this dialog box by 
clicking on "from MP". 
Afterwards, it can be saved. 
Click on "Assume" to transfer 
the customer address entered 
here into a new test log.
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B. Quick selection of the analysis area




By selecting a point in the upper 
graphic with the mouse, the 
selected area will be shown in 
detail in the zoom box below. 















C. Zoom box buttons (VDSL and Cu tests only)



It is possible to adjust the area 
selected using the buttons for 
scrolling that are below the 
graph.


Jump to the beginning or 

end of the graph.



Move the measurement 

area by 1104 kHz or 256 

tones.



Move the measurement 
area by 276 kHz or 64 
tones.
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D. Detailed measurement point information

By selecting a point in the 
"Zoom field" (below: Zoomed) 
with the mouse, you can select a 
detailed measurement point that 
will be marked in yellow in the 
graphic. If the scroll buttons 
below the graphic have not yet 
been activated, the marked 
measurement point can be 
moved right or left using the 

+  /  keys. 
The associated numerical 
values will be shown in the 
information box at the lower 
right. 
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7 Online Trace

Basically this chapter covers two different types of trace:
1. Graphic online trace (for ADSL, VDSL, IPTV and MegaBERT on a PRI/E1 line)

2. D-channel protocol analysis (for an ISDN BRI access)

7.1 The basics of an online trace

To start an online trace, first establish a connection to the ARGUS (see page 36). The trace 
window will then open automatically. In this window, all of the received D-channel signals 
will be displayed online - organized in a table. The layout of the workspace for an online 
trace is shown below.

Workspace - Online Trace
A. see page 17 B. Trace table C. Decoder window D. Graphic display of the test signal  

D

C

B

A 



















In order to trace data online, the ARGUS must be connected to the access to be 

traced (ADSL, VDSL or ISDN) and an ongoing connection must be setup using 

the associated protocol. The ARGUS must run the tests (IPTV, MegaBERT) to be 

traced on the access under test.

If it is not already displayed, you can enable the display of the area marked "D", 

"Graphic display of the test signal", by selecting "View/Toolbar/Graphics" in the 

menu.
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7.2 B. Trace table

WINanalyse will first save all the data sent to your PC during the online trace (on the PC's 
hard disk) before it displays the data in interpreted form on the screen. The original data 
can be displayed in any of eight different analysis levels and is also available to the user for 
renewed analysis at a later time. 



Trace Window Columns 

Column Meaning
No. Consecutive number of the recorded signal.

Source The source of the signal.

Line [TS] The number of available accesses.

Time The time that the signal was recorded.

Direction Direction of the signal.

L2 SAPI Layer 2 Service Access Point Identifier.

L2 TEI Layer 2 TEI-number - terminal identifier.

L2 Type Layer 2 message type.

ARGUS trace information text.

L3 PD Layer 3 Protocol discriminator.

L3 CR Layer 3 Call Reference of the connection.

L3 message Layer 3 message type.

L3 information 
element

The Layer 3 message information element.

The table at the side shows the 
signals received by WINanalyse 
from the connection - presented 
in chronological order in the 
trace area.

If - due to lack of space - some 
of the information in the trace 
table was not displayed, you can 
display this information by 
moving the cursor over the 
desired cell and letting it hover 
there for a moment.












Freezing the signal on the screen

The recorded signals will be presented online on the screen of the PC. To analyse the 
signals at your leisure, you can “freeze” the screen. 
The signals sent in the meantime will still be recorded in the background.

Click on the  button, which can be found in the menu bar above the trace window. Click 

on the button a second time to deactivate the “Freeze screen” function.
If you select a data set to be decoded, the screen will also be "frozen".
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Interrupting the Recording

The recording of data can be interrupted at any time. Click on the  button, which can be 

found in the menu bar above the trace window. Click on the button again to resume 
recording the signals.

Display trace window – decode window

In addition to the trace window, you can also open a decode window. All of the signals will 
be precisely analysed in this window. 
The button bar over the trace window has three buttons to allow you to change how the two 
windows are displayed:

 - Click on this button  if you only want to display the trace window.

 - Click on this button  to display both the trace and decoder windows.

 - Click on this button  to display just the decoder window.

Changing the column width, line height and window size

You can use the mouse to individually adjust the size of the two windows and the column 
widths in the trace window. 
To do so, position the mouse pointer over the right or left line that separates the column 

from its neighbour  (or the outer edge of the window ) that you wish to resize. Press 

and hold the left mouse button while dragging the column’s separating line (or the outer 
edge of the window) to drag it to the desired size.

The line (cell) height for the entire trace table can be adjusted using one of the two buttons 
found above the trace window (not available while recording, rather only during a later 
analysis of a saved trace).

Clicking on this button adjusts the height of the trace table cells  so that all of the 

information in all of the cells will be displayed.
If you click on the  the lines will be restored to their normal height.

Save screen layout

You can save your own individual screen layout and restore it at any time:

Click on  and the current window settings (column width etc.) will be saved. 

Click on  to restore the saved window settings. 





46 WINplus / WINanalyse



7 Online Trace
Split the trace window into two 

If needed, you can split the trace window into two partial windows. Each partial window can 

be scrolled independently. As an example, you can simultaneously view and analyse the 

signals 1 - 10 in one partial window and the signals 10 - 20 in another. 
Using the mouse select the trace window and then select "Split Window".

Change the decoder direction

If you have connected the ARGUS incorrectly and the recorded signals are displayed in the 
wrong direction, you can select "Change Trace Direction" in the "Trace" menu or use the 
context menu to change the direction.
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7.3 Graphic Display of the Recording

Besides the trace and decoder windows, WINanalyse also offers you the option of 
displaying the recorded traces graphically. Please note, however, that you must have 
marked an entry in the trace table and selected the signals in the graphic window that you 
want to view before a graphic will be displayed. 

The graphics here at the side show a typical 
display of an ADSL online trace and the 
related functions for selection or operation.  
Depending on the type of access, there are 
a variety of error counters, connection 
parameters and signals which can be 
selected to be displayed graphically.

7.3.1 The Zoom function 

Using the Zoom function, you can enlarge 
selected sections of the displayed graph for 
more exact analysis. To do this, simply click 
on the  button and then stroke the 
mouse over the area to be enlarged (to 
zoom in on). Afterwards, the cursor will 
change into the following symbol  and 
you can confirm your selection by pressing 
the left mouse button.
Using the right mouse button, you can zoom 

out of this section again. The Zoom function affects all graphics. In other words, the zoom 
factor (magnification) always affects all graphs and signal states equally.
Using the arrow buttons , you can move the enlarged area left and right. If you 
zoom in on a graph during a recording and wish to lock in on the zoomed area, you can 
deactivate the automatic Zoom Shift of the zoomed area by clicking on the  button.
The  button will restore the normal display of the graphs and signal states.
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7.3.2 Graphic display

Depending on the type of connection and test, the individual signals, error counters and 
connection parameters can be displayed graphically in a number of ways.
For more information, see the ARGUS manual. 
Otherwise, note that the number of graphs that can be displayed depends on the size of the 
window so it is wise not to select too many parameters at any one time.

Examples:

ADSL online trace

IPTV online trace

MegaBERT
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7.4 Decode Window

The signals listed in the trace window will be displayed in an analysed form in the decode 
window. To open the desired decode window, select a signal in the trace table and mark it. 

The standard display shows the trace 
and decode windows next to each other, 
however, it is also possible to display 
them stacked one above the other. To 
accomplish this, either open the 
"Window" menu and select "Tile 
Horizontally" or, open the "View" menu 
and select "Decode horizontal" before 
you open the trace file.

7.4.1 Special aspects when working with an ISDN BRI access

All of the D-channel data from the connected BRI access will be displayed online on your 
PC. WINanalyse saves the ISDN D-channel data on your PC, before displaying it decoded 
on the screen. The original data can be displayed in any of eight different analysis levels 
and is also available to the user for renewed analysis at a later time.

Setting the analysis depth

When working in the decode window, there are eight buttons in total to set the depth of the 
analysis.

General information about the signal will be displayed in the decode window under the 
heading ISDN D-channel.

The signal will be presented in hexadecimal coding in the decode window under the 
heading HEX data.

General Layer 2 information will be displayed under the heading Layer 2 (L2).

Additionally, the L2 frame’s bits will be decoded and displayed.

The name of the Layer 3 message will be displayed under the heading Layer 3 (L3).

The content of the most important Layer 3 information elements will be displayed under 
the heading Layer 3 information elements.

All of the Layer 3 information elements will be displayed in clear text.

The bits of the signal frame will be decoded in addition.

The ARGUS will automatically join segmented Layer 3 messages together and display 
them in the decode window.
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Decoding any selected signal

You can have any signal analysed in the 
decode window.
Open a decode window, open the "Decode" 
menu and select "Manual data input", 
enter the direction of the signal and the 
desired signal in hexadecimal and click on 
"OK". The corresponding decode window 
will open.



7.4.2 Filtering a signal


You can filter signals in the trace window using 

a variety of filters. Click on the  button.

A window will open in which you can configure 
the desired filter settings. After you configured 
the desired filter settings, you can save these 
by clicking on the "Save" button. 
Click on "Load" to access all of the saved filter 
configurations. 
The filter settings made can be activated and 

deactivated by clicking on the  button.

The default settings can be restored by clicking 
on the "Default" button.
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7.5 Additional Online Trace Functions

7.5.1 Opening a saved trace file

Trace files that have been saved on your PC 
can be viewed again, analysed or printed at 

any time. Click on the  button or open the 

"File" menu and select "Open trace file…".
In the window that opens, navigate to and 
select the trace file that you wish to open. You 
can also select which window and filter settings 
should be opened with the selected trace file. 
After you have chosen the desired settings, 
confirm your selections by clicking on "Open". 
The trace window will open displaying the 
saved trace data.
Multiple trace files can be opened 
simultaneously and e.g. displayed next to each 
other on the screen and analysed (in the 
“Window” menu select “Tile horizontally”).
 

7.5.2 Text search in a trace record

You can search for any term (e.g. SETUP) in 
the decode and/or trace window. To do so, click 

on the  button.   

Enter the text that you wish to search for in the 
“Search text:” field. 
The search process can be refined by selecting 
one or more areas (e.g. trace window, decode 
window and the column and row selections). 
To refine a search, click on the  button and 

select the desired search options.
Start the search by clicking on the “Next” 
button. The hits (search terms found) in the 
trace and/or decode window will be marked. 
If there are multiple hits, you can jump to the 
next hit by clicking on "Next".
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7.5.3 Printing

Click on  to print the desired trace record. 

Alternatively, you can open the "File" menu 
and click on the same function.
Afterwards, a dialog box will open in which you 
can select whether you want to print the entire 
record or just a selected section. 
Additionally, you can set the print range, the 
printer and the number of copies. 

7.5.4 Stopping a recording

To stop your trace recording, select "Close" in 
the "File" menu. Afterwards, a dialog box will 
open offering the option of first saving your 
trace.
At this point, you can save the trace under any 
file name.
Additionally, you can set where the file should 
be saved under "Save in".
Finish up by clicking on "Save". Your trace 
recording will then be stopped and saved.
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8 The ARGUS Update Tool

Please pay close attention to the messages in the notice window of the Update Tool as well 
as any that appear on the ARGUS display. The update is not complete until the Update Tool 
reports that the update was successful and the ARGUS has returned to the normal startup 
screen after being automatically restarted by the Update Tool.

Do not disconnect the ARGUS from the PC and power until the update is completely 
finished. Prematurely disconnecting the ARGUS from power or the PC or switching the 
ARGUS off prematurely may damage the tester to the extent that it must be sent in for 
repairs or may cause substantial errors.


Starting the ARGUS Update Tool 
Start the ARGUS Update Tool from the 
Windows Start menu. Begin by selecting the 
program group "ARGUS Software" and 

then click on the  "Update Tool" icon. 





Setting the port and speed
In the window that opens, select the COM 
port to which your ARGUS is connected and 
the desired baud rate. 
If the "Maximum" is selected for the speed, 
the Update Tool will select the maximum 
speed possible itself.
At this time, the connected ARGUS should 
be off.



Now connect the ARGUS to the included power supply and make certain that the power 
supply remains on. Connect the ARGUS to the PC's serial or USB interface and make 
certain that this connection also does not get interrupted during the update.

Finally, click on "Next" to continue.
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Detection of the connected tester

Now switch your ARGUS on.
The ARGUS's current firmware version and 

serial number will be read out automatically. 

Afterwards, click on "Next" to open the 

"Select Firmware" dialog box.


Select the desired firmware file that should 

be sent to the ARGUS and then confirm your 

selection by clicking on "OK".
The Update Tool displays all of the firmware 
files that are suitable for the connected 
tester and can be used. If there are files in 
the selected directory that are suitable for 
the connected tester but are not shown by 
the Update Tool, it is likely that your Update 
Tool is an older version and cannot handle 
these firmware variants. The file type of 
firmware files for a specific ARGUS may 
differ. In this event, you can download an 
update for your Update Tool from 
www.argus.info.

Under no circumstances, should you manually rename a firmware file to change 
its file type. This could cause serious damage to your ARGUS.



Checking the settings and starting the update

A summary of the settings made will be 
displayed. Check and make certain that all 
of the settings are correct.
To start the update click on "Next".







If any problems occur or in the rare event that it becomes clear that the selected 
file is not correct or possibly even damaged, you can click on "Back to Step 2" 
to select a different firmware file. 
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The update will begin automatically with the next step.


The update process

During the update, a bar chart will indicate 
how it is progressing and show both the 
percentage done and the time remaining 
before the update will be completed.









Once the transfer is done, the Update Tool 
will inform you as to whether the transfer 
was successful. Afterwards, you can close 
the program or update another tester. When 
you click on one of the two buttons, the 
tester that was just updated will 
automatically restart.




The update is not done until the ARGUS has restarted. Make certain that the 
connection between the ARGUS and the PC is not interrupted until the update is 
completely finished. The ARGUS may not be updated while operating in battery 
mode. It must be connected to its mains power supply.
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A) Acronyms 
Characters

3PTY Three Party Conference

.amp ARGUS measurement protocol - file format

.csv Comma Separated Values - file format

.zip ZIP archive - file format

A

Al Action Indicator

AOC Advice of Charge

AOC-D Advice of Charge
during and at the end of the connection

AOC-E Advice of Charge
at the end of the connection

ATM Asynchronous Transfer Mode

AZS Automatic zoom shift

B

BC Bearer Capability

BER Basic Encoding Rules / Bit Error Rate

BERT Bit Error Rate Test

C

CALL PROC CALL PROCeeding message

CCBS Completion of Calls to Busy Subscriber

CD Call Deflection

CDPN CalleD Party Number

CF Call Forwarding

CFB Call Forwarding Busy

CFNR Call Forwarding No Reply

CFU Call Forwarding Unconditional

CGPN CallinG Party Number

CLIP Calling Line Identification Presentation

CLIR Calling Line Identification Restriction

COLP Connected Line Identification Presentation

COLR Connected Line Identification Restriction

COM Component Object Model

CONN CONNect Message

CONN ACK CONNect ACKnowledge Message

CR Call Reference

CRC Cyclic Redundancy Check

CT Call Transfer
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Cu Copper (from Latin: cuprum)

CUG Closed User Group

CW Call Waiting

D

dB Decibel

DHCP Dynamic Host Configuration Protocol

DISC DISConnect Message

DMT Discrete Multitone Transmission

DSL Digital Subscriber Line

DSS1 Digital Subscriber Signalling System No. 1

DTMF Dual Tone Multi Frequency

E

E1 Primary rate access (PRI), Leased Line

E-DSS1 European Digital Subscriber Signalling System Number 1 

EOC Embedded Operations Channel

ETH Ethernet

F

FEC Forward Error Correction

G

GHz Gigahertz

H

HEC Header Error Checksum

HEX Hexadecimal

HLC High Layer Compatibility

HLOG The amplitude component of the transfer function or each tone

HOLD Call Hold

I

IPTV Internet Protocol Television

ISDN Integrated Services Digital Network 

INFO INFOrmation Message

K

kHz kilohertz

Config. Load configuration from PC

L:

L1 Layer 1 in the OSI reference model

L2 Layer 2 in the OSI reference model

L3 Layer 3 in the OSI reference model

LAN Local Area Network

LAPD Link Access Procedure - D-channel 

LLC Low Layer Compatibility
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M

MB Megabyte

MCID Malicious Call Identification

MDI Media Delivery Index (RFC 4445)

MegaBERT E1 BERT on all B-channels simultaneously

MOS Mean Opinion Score

MP Test Log (measurement protocol)

N

NSF Network Specific Facilities

NT Network Termination

O

OAM Operations, Administration and Maintenance

P

PD Protocol Discriminator

PESQ Perceptual Evaluation of Speech Quality

PID Packet Identifier

PPP Point-to-Point Protocol

Q

QLN Quiet Line Noise

R

REL RELease Message

REL ACK RELease ACKnowledge Message

REL COMPL RELease COMPLete Message

RJ Registered Jack for telephone lines

RTCP RealTime Control Protocol

RTP RealTime Transport Protocol

S

BRI S/T BRI (Basic Rate Interface)  access (an access with an S-Bus) 

PRI Primary Rate Interface access (PRI access) 

SAPI Service Access Point Identifier

SCI Sending Complete Indication

SEG SEGmented messages

SHDSL Single-Pair Highspeed Digital Subscriber Line 

SIP Session Initiation Protocol

SNR Signal-to-Noise-Ratio

SUSP SUSPend Message 

T

TDR Time Domain Reflectometry

TE TErminal, Terminal Equipment

TEI Terminal Endpoint Identifier

TP Terminal Portability
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TS Technical Specification

U

USB Universal Serial Bus

UUS User-to-User Signalling

V

VCI Virtual Channel Identifier

VDSL Very High Speed Digital Subscriber Line

VoIP Voice over Internet Protocol

VPI Virtual Path Identifier

W

WAN Wide Area Network

X

xDSL Collective term for different DSL variants
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